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关于 i-Tree（About i-Tree） 

i-Tree是来自美国林务局最先进的同侪评阅（peer-reviewed）软件套件，其提供

都市及小区林业分析与效益评估工具。i-Tree 工具藉由量化环境树木提供的服

务及评估都市林结构，以帮助各种大小的地区加强他们的都市林管理与推广

度。 

 

i-Tree已被小区、非营利组织、顾问、志工及学生用于记录各种规模的都市

林，从单一树木乃至小区、都市甚至整个国家。透过了解当地树木实际提供的

生态系服务，i-Tree使用者可连结都市林管理活动、环境质量及小区的可居住

性。无论研究目标为单一树木或整个森林，i-Tree的基础数据供你证明价值及

确定优先度以做更有效的决策。 

 

由美国林务局与众多合作伙伴共同开发，i-Tree设于公共网域上，可向 i-Tree网

站（www.itreetools.org）索取授权。林务局、Davey树木专家公司（Davey Tree 

Expert Company）、植树节基金会（Arbor Day Foundation）、市植树师学会

（Society of Municipal Arborists）、树木植栽国际协会（International Society of 

Arboriculture）以及 Casey Trees 皆已成为合作伙伴以利未来发展、传播与为此

套件提供技术支持。 

 

i-Tree产品（i-Tree Products） 

i-Tree软件套件 5.0版本包含以下各都市林分析工具及应用程序。 

 

i-Tree Eco 提供整个都市林的概况。其使用来自小区随机分布样区的现场数据

及当地每小时空气污染和气象数据，以量化都市林结构、环境影响与对小区的

价值。 

 

i-Tree Streets侧重于生态系服务及一个都市行道树族群的结构。它使用一个样

本或完整数据库量化并将每棵树的年度环境与美学效益以美元价格计算，包含

节约能源、改善空气质量、减少二氧化碳、雨水控制及房地价增幅。 

 

i-Tree Hydro 是第一个针对植被的都市水文模型。其模拟都市林覆盖变更的影

响，及流域层不透水表面的每小时河流流量和水质。 

 

i-Tree Vue让你自由使用全国土地覆盖数据库（National Land Cover Database，

NLCD）的卫星图像以评估小区的土地覆盖，包含树冠及当前都市林提供的一

些生态系服务。其也可模拟种植方案对未来效益的影响。 

 

i-Tree Species Selector 是一个独立的工具，用于帮助都市林管理者根据环境功
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能和地理区域选择最适合的树种。 

 

i-Tree Storm帮助你在一场严重的飓风天灾过后，立即以简单、可靠又有效的

方式评估广泛的小区损害。它适用于各种小区类型及大小，并提供关于时间与

减轻灾害所需资金的信息。 

 

i-Tree Design 是一个简易的在线工具，提供一片树林中单一树木的评估平台。

此工具连接 Google地图，使你了解树木选择、树木大小及放置位置将如何影响

能源使用和其它效益。此工具仍在早期开发阶段，更多精密的功能选项会在未

来版本释出。 

 

i-Tree Canopy 提供一个快速简便的方法，透过使用适合的 Google Maps 航空图

像，产生土地覆盖类型（如，树木冠盖）的有效统计性的估计。透过使用这些

数据，城市森林管理者可估计树冠覆盖、设立树冠目标，及顺利地进行追踪，

且能为 i-Tree Hydro和其它需要土地覆盖数据的项目估计所需数值。 

 

免责声明（Disclaimer） 

本出版物中所使用之商品、商号或公司名称仅为提供读者信息和便利，并非排

除其它可能适合之任何产品或服务的使用方式，所提及之商品、商号或公司名

称也非受到美国农业部或林务局的官方认可或批准。标签「i-Tree Software Suite 

v. 5.0」所发布之软件，将不提供任何形式的担保。它的使用受到最终用户许可

协议（End User License Agreement，EULA）管辖，使用者在安装前需先同意接

受该协议。 

 

回馈（Feedback） 

i-Tree开发团队积极寻求关于此产品的任何回馈意见：软件套件、使用手册，

或是开发、推广、支持和精细化的过程。请将评论根据 i-Tree支持页面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介绍（Introduction） 

i-Tree Vue是一个独立的应用程序，其允许你使用免费的国家土地覆盖数据库

（National Land Cover Database，NLCD）卫星图像，评估你的小区树冠及你都

市林提供的某些生态系统服务。此应用程序也可不同种植方案对未来生态系统

服务之影响。 

 

i-Tree Vue提供用户许多更有效应用 NLCD 数据的方法。你可以使用 Google 

Maps 画出基础研究区域边界的轮廓，根据美国林务局的研究调整树冠及不透水

层估算，一点一点更新土地覆盖以取得自 NLCD 发行日期起所发生的变化纪

录，并使用 Google Maps 空拍图与地图数据改善 NLCD 图像分析。 

 

了解你小区都市林及为良好的管理工作建立基础的最佳方式是实地收集真实数

据，包括树种、树木大小及健康；i-Tree Eco 与 i-Tree Streets 两个应用程序能帮

助你执行此任务。然而，有时候针对树冠及与树相关的效益之广泛估计是有帮

助的，无论是作为更深入了解的第一步，或因为时间及财政资源有限。Vue专

为此情况设计。 

 

i-Tree Vue提供以下优点： 

 针对树冠、空气污染相关之排除、碳储存与美国邻近地区年度碳封存，

它提供广泛的估计。 

 它允许你轻松地探索 NLCD图像与信息。 

 它为研究区域提供针对土地覆盖与不透水层的广泛估计。 

 不需要任何实地数据。 

 不需任何软件训练或 GIS 技术以执行它。 

 不需大量都市林知识。 

 许多区域的结果报告可于一个小时内完成。 

 空间性地呈现树冠与生态系统服务，让你看见它们在你的小区范围的差

异。 

 生态系统服务的数量与财政数值使用易于了解的摘要方式呈现。 

 可模拟树冠变化的影响。 

 

Vue也有需注意的限制。这些与 NLCD 数据的性质（土地覆盖数据是从 30 公尺

分辨率的卫星图像取得，且可能是几年前的数据）、使用状况、全国平均空气污

染排除和全国平均碳储存有关。这些限制将于〈附录一〉详细讨论。 

 

关于本手册（About This Manual） 

本手册涵盖所有使用 i-Tree Vue与更加认识你小区都市林所需的所有信息。其

内容分为以下章节： 
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探索 Vue（Exploring Vue）：在几分钟内熟习华盛顿特区（Washington 

D.C）的 Vue及 NLCD 资料。 

 

第一节：开始进行（Section I: Getting Started）。在本节中，我们说明如何

收集免费的 NLCD 数据以执行 Vue。它可能比你所想的更容易！ 

 

第二节：使用 Vue（Section II: Working with Vue）。在本节中，你将体验

简单的控制与软件执行的方式。 

 

第三节：生态系统服务（Section III: Ecosystem Services）。在本节中，我

们说明一项分析报告，其将估计你都市林的贡献与未来潜力。 

 

第四节：更新土地覆盖数据（Section IV: Updating Land Cover Data）。我

们将示范应如何更新你的 NLCD 数据，以更善用美国林务局的信息，并反

映自图像拍摄后，你研究区域的变化。 

 

附录一（Appendix 1）：附录一提供关于 i-Tree Vue限制的详细说明、一些

技术性注意事项，以及基础数据取得方式的相关信息。 

 

附录二（Appendix 2）：附录二提供 NLCD 图像与 ArcGIS v9.x 及 v10 进阶

钉选的说明。 
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安装（Installation） 

 

系统需求（System Requirements） 

最低硬件： 

 1 GHz 处理器与 1 GB 内存。 

 显示器分辨率 1024 x 768 或是更佳 

 

最低软件： 

 Microsoft Windows 操作系统 XP SP3 或更高。 

 IE 7浏览器或更高。 

 Adobe Reader 9.0。 

 

安装（Installation） 

欲安装 Vue： 

1) 进入此网站（www.itreetools.org）下载软件，或将 i-Tree软件安装光盘放

入 CD/DVD光驱中。 

2) 按照屏幕的指示执行 i-Tree setup.exe档案。根据所需的安装档案不同，

这将花几分钟的时间。 

3) 按照安装小精灵的指示以完成安装（建议安装在默认路径）。 

 

注：一定要进入此网站（www.itreetools.org）以取得更多信息、电子报与用户

论坛。并请记住，定期使用应用程序的定期检查更新（Check for Updates）功

能，确保你拥有最新版本，因为我们将持续努力改善 i-Tree！ 

 

探索 Vue的范例项目（Exploring Vue with the Sample Project） 

欲开始背景设于华盛顿特区（Washington D.C）的 Vue功能，你可以跳到〈第

二节：使用 Vue〉，使用内建的范例项目。否则，从〈第一节〉开始，收集分析

你都市林所需之 NLCD 地图。 

  

http://www.itreetools.org/
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第一节：开始进行（Section I: Getting Started） 

 

获得 NLCD图像（Obtain NLCD Imagery） 

你需要为你的研究区域从 NLCD下载三个图像：土地覆盖、森林树冠百分比以

及不透水层百分比。Multi-Resolution Land Characteristics Consortium（MRLC）

是负责建立与维护 NLCD的机构。他们的网络检窗口是你获得必需图像的管

道。我们高度建议你复习他们的检窗口指示。 

1) 进入此网站（www.mrlc.gov/finddata.php）并点击 MRLC Consortium 

Viewer的页面连结。 

2) 点击 MRLC Consortium Viewer。允许你的浏览器开启 MRLC 的弹跳性

窗口。 

3) 使用左侧的缩放（Zoom）工具以准确地于窗口中聚焦在你的研究区域。 

4) 你可以使用 Display Tab 下的类别，例如地区、交通、边界及水文，帮助

你划清边界。 

a) 点击每个类别左侧的三角形以展开选项，再勾选选框以于

地图上显示信息。 

5) 聚焦于你研究区域后，请点击右侧的 Download Tab，再点击土地覆盖旁

的三角形，并为所需年份选取以下图层： 

a) NLCD 20xx Land Cover 

b) NLCD 20xx Forest Canopy 

c) NLCD 20xx Impervious Surface 

 

选择年份时请注意：森林树冠数据不适用于 2006，但 2001的森林树冠数据可

和 2006 的其他图层数据混合。1992年的 NLCD 数据不兼容于 Vue。 

 

6) 使用在左方工具栏中的长方形 Download Tool在地图上沿着你的研究区

域描绘一个框。让框线范围稍微超出你的研究区域。 

7) 在开启的弹跳窗口中，确定三张图像皆已列出，因为这三张图像需同时

下载以确保它们有完全相同的范围。 

a) 于每一图层点击 Download Button 时，Save File窗口将

开启。根据服务器需求，这两个步骤间的等待时间可能会

很长。 

b) 点击 Save后，浏览至欲储存下载文件的位置。将它们的

预设名称变更为「Land_Cover」、「Tree_Canopy」以及

「Impervious」较为适当。 

在你偏好的位置将各压缩文件解压缩并记下这些位置，因为你在〈第二节〉中

将需要它们。各解压缩文件夹包含一个元数据档案（in .html 格式），其提供数

据的所有背景信息。 
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钉选 NLCD图像至项目区域（Clipping NLCD Imagery to a Project 

Area） 

由于 NLCD数据下载为长方形图像，像数字相机照片，你可能需要裁切出你项

目区域的具体边界。这将限制 Vue分析你确切研究区域中的树冠。如果你熟悉

GIS 操作，你可以复习附录二，该章节解释如何使用 ArcGIS 精确裁切你的

NLCD数据。或者，前往〈第二节〉，应用 Vue的简易钉选功能以使用 Google 

Maps 绘制你项目区域的边界。此功能最适合小型、单一的区域。 
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第二节：使用 Vue（Section II: Working With Vue） 

欲开始使用 Vue工作： 

1) 点击你计算机的开始选单 > 所有应用程序 > i-Tree > Vue。 

2) Browse for NLCD Imagery 窗口将开启。 

 

请注意：如果你有意探索模板图像，请点击右下角的 Explore Sample 

Imagery。在开启的弹跳式窗口内，你有两个选项：使用未裁切的图

像或使用裁切的图像工作。 

1) 若选择选项一，使用未裁切的图像工作，你可以按照下方〈在

NLCD 图像上定义 AOI区域〉的指示操作。 

2) 若选择选项二，使用已裁切到项目区域的数据工作，你可以按

照下方〈了解 Vue环境〉的指示操作。 

 

3) 点击土地覆盖、树冠及不透水覆盖图片的 Browse按钮，浏览到解压缩

每个档案的文件夹位置。这些为原始的长方形 NLCD图像（如果你按照

〈附录二）的步骤操作，这些将是 GIS-裁切的图像）。 

4) 三个图像皆被加载后，请从下方的 Set Default Pollution Removal Values

下拉式选单中选择正确的州别。这将载入与你的州别内，有关树木的预

设污染排除数值。 

 

请注意：如果你的小区已建立 i-Tree Eco 项目，你可以使用该项目的

结果而非默认资料。欲使用 Eco项目结果，请从下拉式选单中选择 i-

Tree Eco专案。于开启的窗口中浏览至储存项目的位置，接着点击

Open。 

 

5) 若欲在未裁切的 NLCD 图像中定义 AOI区域，请勾选Manually Define 

an Area of Interest 旁的选框。请注意，此选项只适用于未裁切的图像；

如果你已使用 GIS 裁切你的图像，你不应使用此功能。 

6) 点击 OK。 

7) 若选择定义 AOI区域，一个新窗口将开启供你编辑。若选择不定义 AOI

区域，图像将开始处理。处理图像与计算统计数值可能会花一些时间。 

 

在 NLCD图像上定义感兴趣区域（AOI区域）──非必要（Defining 

an Area of Interest on NLCD Imagery-optional） 

若你在以上步骤中选择定义图像的 AOI区域，Define AOI on NLCD Imagery

窗口将开启。你下载的 NLCD图像在右侧，以红线画出你图像范围的 Google 

Maps 在左侧。在这一步骤中，你将在 Google Maps 上绘制你的 AOI区域范

围，细化边缘，接着裁切并另存新文件为新的 NLCD 图像。 
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1) 第一步是在 Google Maps 上绘制你 AOI区域的范围。 

a) 平移（Pan）与缩放（Zoom）Google Maps 画面是必要的。在

地图与卫星视图间切换，以协助你细化研究区域的边线。 

b) 欲开始定义你的 AOI区域，请点击 Draw AOI Footprint 按

钮，之后在 Google Maps 上沿着你的研究区域点击标记。适当

地在你的 AOI区域外绘制你的边界线，此图片由 30m 像素组

成。 

c) 你可以拖曳 Google Maps 的标记以调整边界，你也可以点击以

删除各标记。如需重来，请点击 Start Over按钮。 

2) 完成边界描绘后，请点击 Draw AOI on NLCD 按钮，将 Google Maps 边

界传送至 NLCD 图像窗口。请注意，此窗口是由不同的地图工具套组操

作的；将鼠标光标停留在每一个工具上以阅读工具描述。 

a) 使用 Toggle NLCD Images 按钮于三个图像上描绘，确保你已

取得你的 AOI区域。必要时，使用平移（Pan）与缩放

（Zoom）。 

b) 接着，请点击 AutoClip 以清除边界外大部分的 NLCD画素。

这可能会花点时间。 

c) AutoClip 无法清除全部，因此你可以藉由点击 TouchUp 

Eraser按钮与各像素，移除你 AOI区域边缘与内部的像素。

使用平移（Pan）与缩放（Zoom）提高操作精密度。 

d) 点击 Save后，浏览至欲储存已裁切图像的文件夹。替各图像

依需求命名，接着点击 Save。 

3) 完成后，请点击 OK，Vue将开始处理程序。处理图像与计算统计数值

可能会花一些时间。 

 

了解 Vue设计（Getting to Know the Vue Layout） 

检窗口（Viewports） 

NLCD图像将出现在窗口的左上、右上及左下角。每一张图像皆可藉由点击在

右上角的Maximize按钮最大化。右下角将用于分析结果。 

 

统计面板（Statistics panel） 

统计的卷标页将于 Vue 窗口右侧列出。General 卷标表示你研究区域的树冠及

不透水层（以英亩与百分比）。五种土地覆盖类别的细节会在之后的标签呈现。

Pixel Info 标签让你更仔细地检视各个 30 x 30 m 像素的组成。Classes标签提供

NLCD土地覆盖类别的描述。About卷标提供更多有关 Vue信息的链接，Help

卷标则提供使用 Vue主窗口的指示。 

 

图像工具（Image tools） 
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底部左侧的工具提供透过一般 Zoom与 Pan 功能的图像基本控制，包括 Full 

Extent缩放及 1:1 zoom工具。图像的比例尺也可开启或关闭。你可以直接

Measure（测量）图像数据的分辨率距离（~100 ft/30 m）。Print按钮产生一个

简单的图像四块编排。NLCD Statistics Report 显示关于你研究区域的统计数

值，而旁边的 NLCD Analysis Report显示关于你研究区域的分析报告的统计数

值。将光标停留在工具上以检视工具名称。 

 

Google互动工具（Interactive Google tools） 

GoogleFind 及 GoogleVue 会帮助用户解读 NLCD 数据。GoogleFind 允许你在

四个图像中点击任一个点，以在弹跳窗口中的 Google Maps 上找到该位置。点

击 Google Maps 产生的标记会显示该位置的更多信息。GoogleVue允许你藉由

点击四个图像中的任一点，检视 Google Maps 上迭层的清晰透明的 NLCD 图

像。根据你点击的 NLCD 图片，一组 11 x 11 像素的土地、树木、不透水层或

分析数据将在选择的点产生。此功能允许你检视与比较最近的 Google Maps 图

像与 NLCD图片。当 GoogleVue正在显示 NLCD 土地覆盖数据时，在像素上点

击鼠标右键将显示 NLCD 类别。当 Vue的比例尺开启时，它们也会出现在

GoogleVue地图中。 

 

一旦点击这两个工具，它们将保持启动状态。在 NLCD图片与 Google Maps 窗

口间有一些受限制的缩放和平移互动。Google Maps 窗口可以透过 UL、UR、

LL 和 LR按钮（上下右左）被迭在四个检窗口中的任一个。Undock 它以返回

为自由浮动窗口，而 X将关闭它。使用这两个工具时需要高速网络连接。 

 

单位（Units） 

Units按钮允许你在美国与公制单位间切换。 

 

分析选项（Analysis options） 

使用 Analysis Options按钮以进入都市林业分析总机。这些分析皆为 i-Tree Vue

的核心要素。每一个分析在 Vue主窗口中针对一些生态系统服务提供报告与相

应的可视化。此外，有些选项可供探索不同的树冠覆盖方案。各屏幕右侧及以

下手册内容皆会提供详细的帮助。此分析可分为五种，并于下一节中深入描

述：碳移除 Carbon Removal、污染移除 Pollution Removal、NLCD 覆盖调整

NLCD Cover Adjustments、现有的都市林结构 Existing Urban Forest Structure

以及树冠情境模型 Canopy Scenario Modeling。 

 

最后，分析选项包含在 NLCD Cover Adjustments 下的现状微调 NLCD资料。 
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第三节：生态系统服务（Section III: Ecosystem 

Services） 

透过 Analysis Options按钮取得的生态系统服务分析是 Vue的核心。针对你研

究区域的树冠，年度碳移除（Carbon Removal）和污染移除（Pollution 

Removal）皆会被分析，结果将以移除吨量与美元价值等方式呈现。现有都市

林结构（Existing Forest Structure）分析描述了可用种植空间量和现有树冠覆

盖。树冠情境模型（Canopy Scenario Modeling）提供的方法可试验树冠增加

或损失对研究区域的影响，以及碳和污染清除的相关变化。 

 

大多数的结果描述你研究区域的整体情形，也可依土地覆盖类型细分。碳或污

染的每亩移除量与相关的金钱价值之默认值，是基于国家和州的平均水平（或

你的 i-Tree Eco 专案）。例如，每亩的碳储存量是使用全国平均水平的 9.1 kg 

C/m2或 81,188.3 lbs C/acre和货币价格的$20.68/ton 估计。请记住，各分析结果

皆代表来自树木的效益。例如，农业土地覆盖类型的碳储存报告单指该土地覆

盖类型中的树木碳储存，而非储存于土壤、农作物等的总碳量。 

 

请注意：Vue可为你进行一些基本 NLCD 数据的更改，以产生更精确的结果。

这些程序将在〈第四节〉概述。 

 

碳和污染移除（Carbon and Pollution Removal） 

总碳储存（Total Carbon Storage）分析估算储存于你研究区域树木的碳吨量

（也会显示等量的 CO2吨量）。 

 

年度碳移除（Annual Carbon Sequestration）分析估算你研究区域树木每年从

大气移除的总碳吨量（也会显示等量的 CO2吨量）。 

 

估算树木污染移除量的分析提供一氧化碳（Carbon Monoxide，CO）、二氧化

氮（Nitrogen Dioxide，NO2）、臭氧（Ozone，O3）、二氧化硫（Sulfur 

Dioxide，SO2）和 PM10（Particulate Matter, less than 10 microns）的估计量分

析。 

 

欲开始分析并检视结果： 

1) 在 i-Tree Vue主窗口中，点击 Analysis Options 按钮。 

2) 在之后的分析操作界面中，选择 Carbon Removal 或 Pollution Removal

分析之一，再点击 OK。 

3) 开启的输入窗口将显示你研究区域的默认国家（碳）或州（污染）平均

水平。如果你有更适合的当地信息，可以在此输入。 

4) 点击 OK后，让 Vue花点时间处理信息。此处理程序以像素为单位进
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行，因此可能需要几分钟的时间。 

5) 结果将显示在 Vue主窗口中的 Analysis Output 检窗口。处理完成后，统

计报表也将出现。报告可从图像工具栏取得，直到分析重新设置。 

 

现有的都市林结构（Existing Urban Forest Structure） 

Available Green Space 分析估算的可用种植空间，是总面积减去现有的树冠覆

盖，再减去不透水面。 

 

Canopy Green Space 呈现你研究区域的每亩总树冠量和百分比。 

1) 从 i-Tree Vue主窗口点击 Analysis Options 按钮。 

2) 在之后的分析操作界面中，点击 Available Green Space 或 Canopy 

Green Space，再点击 OK。 

3) 在开启的窗口中，勾选欲分析的土地覆盖类型。 

4) 点击 OK后，让 Vue有时间来处理讯息。让 Vue花点时间处理信息。此

处理程序以像素为单位进行，因此可能需要几分钟的时间。 

5) 结果将显示在 Vue主窗口中的 Analysis Output 检窗口。处理完成后，统

计报表也将出现。报告可从图像工具栏取得，直到分析重新设置。 

 

树冠情境模型（Canopy Scenario Modeling） 

Vue具有一个非常有价值的功能，就是仿真树冠覆盖变化对环境效益的影响。

增加或减少树冠覆盖所造成的影响可透过四个选项探索： 

 

整个地区（Across the entire region）：此选项均匀调整整个研究区域的树

冠覆盖百分比。 

 

依五个一般 NLCD类别细分（Broken down by the five general NLCD 

classes）：此选项可独立调整各开阔土地覆盖类别的树冠变化。 

 

所有已开发的 NLCD区域总和（Across the aggregate of all developed 

NLCD areas）：此选项可调整已开发区域的树冠覆盖百分比，并保留其他

土地覆盖类型的状况。 

 

依四个已开发 NLCD子类细分（Broken down by the four developed 

NLCD sub-classes）：此选项允许你在不同程度的已开发地区，独立调整树

冠覆盖程度。例如，非常密集的城市中心可能有比郊区更低的树冠覆盖目

标。在此选项中，所有未开发地区皆保持不变。 

 

欲调整树冠程度： 

1) 在 i-Tree Vue主窗口中，点击 Analysis Options 按钮。 
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2) 在之后的分析操作界面中，选择其中一个模拟情境方案，再点击 OK。 

3) 所开启的窗口将显示你现有的树冠覆盖程度以及最大可用种植空间（定

义为没有现存的树木和没有不透水层的地区）。 

a) 针对每种土地覆盖，输入欲模拟的树冠覆盖程度。其不可超越

最大可能树冠（Maximum Possible Tree Canopy），若数值低

于现有树冠（Existing Tree Canopy），树冠的损失将被模拟。 

b) 若你希望为任何生态系统服务编辑每英亩或每货币金额的默认

值，勾选每个服务旁的选框。相应的字段将出现以供编辑。 

4) 点击 OK后，让 Vue有时间来处理讯息。让 Vue花点时间处理信息。此

处理程序以像素为单位进行，因此可能需要几分钟的时间。 

5) 结果将显示在 Vue主窗口中的 Analysis Output 检窗口。处理完成后，统

计报表也将出现。报告可从图像工具栏取得，直到分析重新设置。 

 

报告选项（Reporting Options） 

所有 Analysis Options输出处理的时间取决于系统资源和 NLCD图像尺寸。在

较慢的机器上，处理可能需要几分钟。窗口底下的进度条显示处理作业进度。

偶尔，进度会因你计算机上运作的其他系统活动而迟滞。这时，你不应该退出

程序。相反地，你应等待几分钟，让处理完成。 

 

检视（Viewing） 

处理完毕后，Analysis Output 图像将出现在 Vue主窗口右下角的检窗口，而

NLCD Analysis Report 将出现在一个弹跳窗口。分析结果的 Executive 

Summary 表格和 Full Report 皆会提供。点击加号开启新层级，或点击 Expand 

All 以同时检视全部报告。输出图像被用于将整个研究区域的现象可视化，并可

于 Statistics Panel 上的 Pixel Info 标签仔细检视。 

 

打印（Printing） 

该四个图像可依它们显示于当前检窗口的方式与各自的比例尺一起打印。点击

图像工具栏中的 Print 按钮以打印。接着点击开启的 Print Preview 窗口中的

Print按钮。 

 

报告的 Print按钮位于该报告底部。报告将以它们出现在屏幕上的状态被打印

出来──包含各层级的展开或折迭。 

 

保存（Saving） 

欲保存分析输出的图像档案和相应的 NLCD 图像，请点击主窗口右下角的 Save 

Output按钮。浏览至欲储存的位置后，替档案命名，再点击 Save。图像的.tif

档案及 GIS 程序的.tfw 档案皆会被储存。 
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使用报告底部的 Save按钮，可将该报告保存为逗号分隔（comma-delimited）的

文本文件（.csv）。Microsoft Excel 可开启 Executive Summary的逗号分隔文件，

以进一步编辑和格式化。 
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第四节：更新土地覆盖数据（Section IV: Updating 

Land Cover Data） 

在 NLCD数据有局限性。首先，可以确定 NLCD 数据将低估树冠覆盖和不透水

层（参考〈附录一〉了解更多）。其次，因为开发 NLCD图像产物需要很长的

时间，你的研究区域可能会在此期间经历显著的变化。最后，由于 30 x 30 m 像

素的粗糙性，树冠或不透水层的量可能不正确。在某个像素内，小树木或小区

域路面可能会被周遭的土地覆盖「排除（washed out）」。这种图像拥有这些限制

──我们应记住，这种图像是免费的，且能被统计管理。 

 

欲解决以上提到的第一个限制，美国林务局（U.S. Forest Service，USFS）承办

了一个取样活动，透过航空摄影解读技术辨识树冠与不透水层的区域性低估。

这些修订的区域性数值可输入至 Vue以改善结果。另外，你也可以考虑使用 i-

Tree Canopy程序替你的当前树冠百分比进行统计估计。i-Tree Canopy百分比和

i-Tree Vue呈现的 NLCD 数值之间的差异是你的校正因子，且能输入至 Vue。 

 

为了解决第二和第三个限制，Vue的新功能让你于个别像素中，使用 Google 

Maps 针对小区域更新土地覆盖、树冠和不透水层信息。 

 

均匀调整分布在整个研究区域的树冠水平和不透水层（Adjusting 

Canopy Levels and Impervious Cover Evenly Across your Study 

Area） 

欲更改均匀分布在整个研究区域的树冠和不透水层之默认 NLCD信息： 

1) 在 i-Tree Vue主窗口中，点击 Analysis Options 按钮。 

2) 在之后的分析操作界面中，点击 Tree Canopy 或 Impervious Cover，再

点击 OK。 

3) 该二分析窗体呈现 USFS 针对邻近美国地区的研究区域地图和其调整值

列表。 

a) 使用 Zoom和 Pan 操作地图，找到包含大量研究区域的区

块。 

b) 确认你的区块后，针对该区域，点击地图下方列表中的

adjustment factor。上面标记为「差异（Difference）」。相应数

值将出现在上方的框框内。 

另一方面，欲使用根据 i-Tree Canopy调查的校正因子，针对整个研究区域，在

上方的框框内输入 i-Tree Canopy树冠百分比与 i-Tree Vue树冠百分比的差异。 

点击 OK。这些更动将于依像素为单位进行，可能需要几分钟的处理时间。 

 

以像素为单位调整土地覆盖类别（Adjusting Land Cover 
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Classification Pixel by Pixel） 

下方说明将描述如何更改各像素数据的三个部分：（1）土地覆盖分类（例如，

高度开发、混合林、水等），（2）该像素之树冠平均百分比，以及（3）该像素

之不透水层平均百分比。 

 

试想，举例而言，某地区的 NLCD图像产生时，该地区仍是高密度森林区，之

后被开发为一个郊区住宅区。根据 NLCD 数据，这个区域的像素可能会显示为

「森林，落叶（Forest, deciduous）」，并有 100％树冠覆盖和 0％不透水层。然

而，就目前的情况而言，更准确的描述为「已开发，低度（developed, low 

intensity）」，并有 30％树冠覆盖和 20％不透水层。 

 

下方说明将描述如何更改数据的这三个部分。高速网络联机是必要的。 

1) 在 i-Tree Vue主窗口中，使用 zoom和 pan 浏览至 NLCD图像中欲更动

的位置。 

2) 点击 Analysis Options按钮。 

3) 在之后的分析操作界面中，选择 Land Cover 并点击 OK。Google Maps 

Pixel Navigator窗口将开启。 

4) 在浏览窗口中，进一步使用 zoom和 pan 至欲更新的区域。 

5) 点击 Fetch Land Cover Pixel Subset 按钮。NLCD 土地覆盖类别像素将

出现在浏览地图上。你可以在像素上滚动，在地图区域的右下角，土地

覆盖分类、树冠（TC）和不透水层（IC）将显示。 

6) 欲针对个别像素更新土地覆盖、树冠和/或不透水层： 

a) 若欲改变土地覆盖类别，选择地图下方的新土地覆盖类型。 

b) 若欲改变树冠水平，勾选树冠（Tree Canopy）旁的 edit 框，

并移动滑动条至正确的水平。 

c) 若欲改变不透水层水平，勾选不透水层（Impervious Cover）

旁的 edit框，并移动滑动条至正确的水平。 

d) 接着，在地图上右键点击相应像素，以同时更改数据的这三个

部分。 

e) 因此方法主要依赖 Vue 和 Google Maps 的协调，请别过快点

击。 

f) 鼠标光标停在某像素上方时，新数值将出现于右下角的当前数

值（Current values）下。 

g) 欲更仔细检视下方的 Google Maps 细节，你可以点击 Hide 

Land Cover Pixels。点击 Show Land Cover Pixels 以继续使用

它作业。 

7) 点击帮助（Help）面板下的 Advanced 按钮，查看更改后的 NLCD 图像

为何。你可能需要 Zoom及 Pan 这些图像以找到所编辑的区域。 
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8) 编辑各像素后，定期点击 Commit Changes 按钮保存更新后的图像。 

9) 全部的步骤──步骤四至八──根据需要，可重复数次。 

10) 完全完成编辑后，点击 OK。你的已编辑图像将被加载到 Vue中。 

 

若你对默认数据的调整感到满意，你即可返回〈第三节〉，继续分析和检视你已

改善的 NLCD资料的结果。 
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附录一：限制和数据注意事项（Appendix 1: 

Limitation and Data Notes） 

 

限制（Limitations） 

i-Tree Vue提供树冠覆盖和部份都市林生态系统服务的粗略估计，且不要求用户

收集实地数据。如果没有实地数据收集，估计只能算是非常粗糙的近似值，在

数据和估计上也将有些显著的局限性。 

 

尽管有这些限制，i-Tree Vue专为城市地区提供生态系统服务的简单初阶的估计

值。这些数据可以于查看现有覆盖与服务的差异、树木覆盖改变的潜在效益变

化，并作为跳板，使 i-Tree Eco 或 i-Tree Streets 的服务估计更精确。这些数据不

应被视为最后或准确的都市林覆盖或环境服务估计。 

 

广义估计（Generalized estimates） 

i-Tree Vue的基本方法是使用国家土地覆盖数据库（National Land Cover 

Database，NLCD，http://www.mrlc.gov）所开发的空间森林覆盖地图，以及应

用树冠覆盖每单位的平均生态系统服务值，估计当地区域的服务。这个广义作

法使用国家和州平均值，在地方性规模有明显的局限性。 

 

NLCD树木覆盖估计（NLCD tree cover estimates） 

NLCD提供为美国地区提供具 30米像素分辨率的树木覆盖估计。这个国家数据

库提供了我们国家树木资源的重要讯息，但也有其局限性，特别是针对地方性

规模。自 NLCD覆盖地图的树木覆盖估计已被证明全国树木覆盖率平均将被低

估 10％（Nowak and Greenfield 2010）至 28％。同样地，不透水层估计平均被

低估 1.4％到 6％。基于 Nowak和 Greenfield 的成果（2010），Vue 的功能允许

你对区域内的树冠和不透水层粗略调整。 

 

空气污染清除估算（Air pollution removal estimates） 

为更精确地估计城市中的污染清除情形，需要当地的污染和气象数据，以及叶

面积指数（树冠深度）和树冠覆盖的估计。由于地方性数据在 i-Tree Vue中是

未知的（除了树木覆盖估计），i-Tree Vue使用每平方米树冠覆盖的每年污染清

除估计（g/m2/yr）的国家平均值，计算地方性的污染清除，并假设叶面积指数

为 6﹝即是，每平方米树冠覆盖的 6平方米叶面（单面）﹞。随着污染浓度、

天气和都市林叶面积指数可于地方有明显差异，因此，i-Tree Vue估计越粗略越

好。你的区域条件与国家平均值和叶面积指数 6 越接近，i-Tree Vue的估计与你

的区域便越接近。更精确的估算可透过收集当地的实地数据，以及使用 i-Tree 

Eco或 i-Tree Streets。更多有关如何计算污染移除的信息将于下方说明。 
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碳储存与封存估计（Carbon storage and sequestration estimates） 

为更精确地估计城市的碳储存（目前在树木中的碳量）和每年碳封存（一年中

所清除的碳量），当地的环境条件（例如，树木竞争、生长季长度）与树木密

度、物种和直径分布等信息皆是必要的。由于在 i-Tree Vue中，地方性数据是

未知的（除了树木覆盖估计），i-Tree Vue采用全国平均估计以求近似当地的碳

影响。碳封存和储存数值是树木覆盖（平方米）乘以平均碳储存（9.1kg 

C/m2），封存密度值（0.3kg C/m2）则从美国许多城市（例如， Nowak 和 

Crane 2002, Nowak 和 Greenfield 2008）所计算而来。由于树木母群体和环境变

量可在地方有显著差异，i-Tree Vue的粗略估计是最好的。你的区域条件越接近

群体平均，因此，i-Tree Vue估计越粗略越好。你的区域条件与群体平均越接

近，i-Tree Vue的估计与你的区域便越接近。更精确的估算可透过收集当地的实

地数据，以及使用 i-Tree Eco 或 i-Tree Streets。 

 

美元价值估计（Dollar value estimates） 

生态系统服务的货币估算是基于每吨污染物或碳量数值的文献估计。有关城市

树木碳储存和碳封存的货币价值，是根据 2001-2010年预计的边际社会二氧化

碳排放成本，为$22.8/t C（Fankhauser 1994）。污染清除的美元数值估算，是使

用从 1994 年在能源决策中制定的国家客观性中间值进行估计（Murray et al. 

1994, Ottinger et al. 1990）。基于生产者价格指数，将 1994年的数值调整至 2007

美元（U.S. Dept. of Labor 2008）。这些数值，以美元/吨（t）为单位，分别如

下： 二氧化氮（NO2）= $9,906/t，PM10 = $6,614/t，二氧化硫（SO2）= 

$2,425/t，一氧化碳（CO）= $1,407/t。对于臭氧（O3）的客观值设定为等于二

氧化氮（NO2）的数值。客观值可被认为是产生该污染之产品或服务的市场价

格针对社会的污染估计成本。 

 

估算空气污染移除的方法（Methods for Estimating Air Pollution 

Removal） 

空气污染清除的估计来自于 Urban Forest Effects（UFORE）模型（Nowak 和

Crane 2000）以及 2000 年气象和污染数据（National Climatic Data Center 2000, 

U.S. EPA 2008）。UFORE 模型被用于整合城市或小区的树木覆盖数据中，每小

时污染和气象资料，以估算各州的每年污染清除（Nowak and Crane 2000, 

Nowak et al. 2006）。 

 

欲计算各州的城市森林污染，州污染通量率（每年每树冠平方米的污染清除公

克数）是来自 1994年都市林移除国家污染的研究（Nowak et al. 2006）。随着污

染物浓度因时间而变化，根据 1994年与 2000年间的平均区域污染浓度改变，

1994年污染通量率被调整为 2000年（U.S. EPA 2003）。通量率＝沈积速度*污

染浓度，每年间的污染浓度比率被用于更新通量率。 
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算术平均值被用于二氧化氮、PM10和二氧化硫浓度值；2nd max 8小时二氧化

碳平均值；和 4th max 8小时臭氧平均值，以确定 1994年和 2000年间的变化率

（U.S. EPA 2003）。新的 2000年通量率乘以城市或小区树木覆盖值，可估计树

木的总污染清除数值。 

 

NLCD图像技术说明（NLCD Imagery Technical Notes） 

多元学习（Learn more） 

参考Multi-Resolution Land Characteristics Consortium（MRLC）网页

（www.mrlc.gov），以学习关于他们的目标以及 NCLD数据在 i-Tree Vue的应

用。特别检阅他们 FAQ部份的 NCLD数据简报。 

 

四舍五入（Rounding） 

NLCD图像数据的每一个图像像素，皆以数值 0 到 100储存。因此，新的树冠

估计结果必然四舍五入。四舍五入在输出的树冠数据组中，可能会扭曲用户定

义的树木覆盖估计高达百分之一。当你在处理涵盖非常小的 AOI区域的区块或

土地覆盖时，扭曲将更加明显。此外，碳和污染数值并不实际储存于图像像素

中，因四舍五入它们将降低有效性。相反地，树冠—现存或新估计—皆被储存

于图像像素中。在 i-Tree Vue中，碳和污染数值皆实时计算，以显示于像素讯

息窗中。碳和污染图像输出后，你可以使用你 GIS 程序中所选择的碳和污染数

值乘以储存后的树冠数值。 

 

投影系统（Projection system） 

请参照 www.mrlc.gov 或图像附加的元数据文件以获取更多讯息： 

Projection ALBERS 

Datum NAD83  

Spheroid GRS80  

Units METERS  

Zunits NO  

Xshift 0.0  

Yshift 0.0 

Parameters  

29 30 0.0 /* 1st standard parallel  

45 30 0.0 /* 2nd standard parallel  

-96 0 0.0 /* central meridian  

23 0 0.0 /* latitude of projection’s origin  

0.0 /* false easting（meters）  

0.0 /* false northing（meters） 
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附录二：使用 ArcGIS钉选 NLCD 图像（Appendix 

2: Clipping NLCD Imagery with ArcGIS） 

Vue提供了一个简单的功能，能将 NLCD 的图像范围钉选到你的研究区域，但

如果你能使用 GIS，透过 GIS 的强大功能，你将发现能更容易地裁切并钉选。 

 

ArcGIS v. 9.3 & v. 10 

ArcGIS v. 9.3或 v. 10 可于来裁切钉选图像，并不需要任何扩充套件。 

1) 加载三个 NLCD 图像到新的 ArcMap项目「FIRST」。这将投影系统设置

以符合图像，是 Vue正常运作的关键。不要重新投影 NLCD图像，这将

扭曲 NLCD图像的像素，并舍弃 Vue的所有运算。 

2) 欲提取来自各 NLCD图像的投影区域，请浏览 ArcToolBox > Data 

Management Tools > Raster > Raster Processing > Clip。 

3) 如下填写裁切表格： 

a) Input Raster应为从MRLC 网站下载的不透水层、树冠或土地

覆盖图像。 

b) Output Extent 是欲钉选的多边形边界 shapefile。 

c) 勾选 Use Input Features for Clipping Geometry (optional)旁的

选框。 

d) 对于 Output Raster Dataset，在你的硬盘上，浏览至一个合适

的位置，以.TIF檔名命名该输出数据集（Output Dataset）：

「your_layer_name.tif」。请注意：TIF 和 TFW 档案将于选定

的输出位置被创建。 

e) NoData Value (optional)应留空。 

4) 完成后，关闭 ArcGIS 以开启用于 Vue的钉选图像档案。 

 

ArcGIS v. 9.2 

使用 ArcGIS v. 9.2的用户需取得 Spatial Analyst 扩充程序进行裁剪。 

1) 为使用 Spatial Analyst，在 ArcMap的主选单中，选择 Tools > 

Extensions > Spatial Analyst。 

2) 加载三个 NLCD 图像到新的 ArcMap项目「FIRST」。这将投影系统设置

以符合图像，是 Vue正常运作的关键。不要重新投影 NLCD图像，这将

扭曲 NLCD图像的像素，并舍弃 Vue的所有运算。 

3) 欲提取来自各 NLCD图像的投影区域： 

a) 请浏览 ArcToolBox > Spatial Analysis Tools > Extraction > 

Extract by mask。 

b) 将你项目的 AOI多边形图层地图设置为面板。 

4) 欲输出三个提取的数据集： 
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a) 右键点击 layer name > Data > Export Data。 

b) 更改输出数据的位置（记住，只要在输出活页夹位置上点击一

次即可）。 

c) 更改格式为 TIFF。 

d) 根据需求调整名称。 

e) 保留其他选项的默认值。 

5) 按照以下步骤，创建三个输出图像的World File（*.TFW）：

ArcToolBox > Data Management Tools > Raster > Raster Properties > 

Export Raster World File。 

6) 完成后，关闭 ArcGIS 以开启用于 Vue的钉选图像档案。请注意，Vue原

先可能以灰阶模式呈现这些图像，但仍会尝试替每个图像应用适当的颜

色。 

 

 


